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This Brand New Step-By-Step Video Training System Shows 
Anyone To Go From Complete Newbie To Confident Photoshop 

Elements User In Just 2 Hours...

Click here to Discover this free video tutorial which shows you how to easily correct one of the most 
common graphic problems (I'm sure your computer is FILLED with graphics that have this problem 
and are dying to know how to fix it)... 

You’ll soon be able to edit your digital photos with fun and ease! - With these video tutorials (which you can 
watch online or download to your own computer) it's like looking over my shoulder as I show you how I 
create and modify all types of photos.

"Learn Elements Now" will teach you all of the following tools and editing tricks;-

... Find and view all my photos and video clips for quick editing

... Add backgrounds, shadows, and lighting to them

... Fix my common photography problems like red-eye, blurring, and color issues

... Crop and resize my photos without compromising quality

... Make my photos look their best with easy-to-use editing tools

... Easily perform more advanced retouching and enhancing thanks to the easy image-selection tools, and 
amazing compositing capabilities

Click Here to Master Elements In Just 2 Hours 
- Guaranteed (Even If You're A Total Newbie)!
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Adobe Elements: One Of The Best Image 
Editing Softwares
Photoshop is widely considered the best image-editing software in the world today by a 
long way, and it is not difficult to see why. Photoshop offers incredibly advanced effects 
which would previously have taken days or weeks to accomplish, and reduces them to the 
level of a few settings and a few clicks.

Although it is expensive, today it is considered an essential program for anyone working 
with graphics, whether it’s in print, on the web, or even in television and movies. This has 
led to a huge number of cheaper competitors (who have been largely ignored), as well as 
rampant piracy of Photoshop itself. To counter this, a cheaper, simpler version of Photoshop 
called Photoshop Elements is now available, which is especially good for beginners.

How did Photoshop get into this dominant position? Well, development started in 1987, 
with the first release in 1990. Since then, Adobe has been improving the software 
continuously, constantly taking advantage of advances in hardware power. Even now, to get 
the best performance out of Photoshop, you should buy as much RAM as you can afford.

It is not just Adobe’s efforts that have got Photoshop where it is today, however. The 
program’s plugin architecture has allowed there to be are all sorts of plugins available for 
more advanced work, including some plugins that actually cost more and do more than the 
program itself. In this way, Photoshop is often used much like Windows, as a platform – and 
it would be a huge effort to get these plugins to run on any other software, making 
competitors effectively useless to anyone who relies on a plugin.

Today, you can get Photoshop for Windows and Mac OS (both OS 9 and OS X). If you want 
to use it on Linux, however, you will have to use Crossover Office, Codeweavers’ program 
that allows some Windows software to run on Linux, but it will be quite slow
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Photoshop vs. Elements
If are not planning to use Photoshop professionally, or if you are new to the world of photo 
editing, the scaled down version of Photoshop, Photoshop Elements, may be just what you 
are looking for. 

Photoshop retails for over $500, while Elements can be found for a 
much  more  reasonable  $99.  Elements  contains  all  the  features 
necessary to remove speckling and damage from images, crop and 
rotate  images,  create  professional  looking  graphics,  and  create 
attractive special effects in your photos. Elements also allows for the 
creation of artistic effects, color and lighting adjustment, and layer 
effects. 

Unless  you  plan  to  regularly  use  custom  printing  separations  and  high-end  color 
management, the huge variety of professional options you pay for when purchasing the full 
version of Photoshop will go unused.

Photoshop Elements is much easier for the beginner to learn, as well. Please know that if 
you have purchased Photoshop Elements and feel constrained by its limitations, it is an easy 
upgrade to the full version through the Adobe website.

Getting to Grips with Adobe Elements

The Elements Interface
As you know, Elements doesn’t have a single interface as you can launch the program in 
several modes. This all depends on what your doing; Organising your images, Full edit 
mode, Quick Fix, or a really cool feature is to create options to produce photo books. 

If you have Elements, you’ll also notice some more really cool features like; Email, Burning 
to CD or DVD, and also a real plus is that the interface is less cluttered, which makes your 
life easier when you’re moving around the screen.
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Quick Fix Guide Mode 
The quick mode enables you to make very basic alterations to your images as you can alter 
the following; Lighting, colour, sharpen, and you also have the options to do a smart fix.

Elements also gives you an auto fix button which can be found on the right hand side.

Another way to access the adjustments buttons is through the Enhance menu.

Auto fixing is a real help if you’re a complete novice at image editing and if you're after a 
quick fix to your image. Here are six great short tools and features.

1 - Sometimes you’ll find your editing isn’t going the way it should be, so you can just hit 
the "Reset Button" on the after picture.

2 - If you need to show your before and after images, there’s a drop down button in the 
bottom left hand corner, which says "View".

3 - Your tool box can be found on the left hand side of the screen.

4 - You can zoom in from your image on this page and the zoom button can be found in the 
bottom left hand corner.

5 - Your auto tab buttons can be found on the right hand side of the screen.

6 - Each quick mode gives you the option of using sliders.

Full Edit Mode
The full edit mode gives you everything you need to alter any of your images. You’ll find 
that most of the tools and commands are found in the palettes. 

The palettes are used for managing your layers and applying effects to your images. By 
default the layers and effects palette are displayed automatically. If you wish you can also 
open more by choosing from the windows menu, which can be found at the top. Another 
really cool feature for the palettes is they float, so you can have them where you like. Once 
you have brought your image up, you’ll find below the main image window your images 
that you have opened. 
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Elements Quick Fix Guide Mode
The quick mode enables you to make very basic alterations to your images as you can alter 
the following; Lighting, colour, sharpen, and you also have the options to do a smart fix.
Elements also gives you an auto fix button which can be found on the right hand side. 
Another way to access the adjustments buttons is through the Enhance menu.

Auto fixing is a real "God Send" if you're a complete novice at image editing and if you're 
after a quick fix to your image.

As you can see from the image below, the two images have been altered. You can see the 
before and after, with the after being on the right.

Six great short tools and features
1 - Sometimes you'll find your editing isn't going the way it should be, so you can just hit 
the "Reset Button" on the after picture.

2 - If you need to show your before and after images, there's a drop down button in the 
bottom left hand corner, which says "View".

3 - Your tool box can be found on the left hand side of the screen.
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4 - You can zoom in from your image on this page and the zoom button can be found in the 
bottom left hand corner.

5 - Your auto tab buttons can be found on the right hand side of the screen.

6 - Each quick mode gives you the option of using sliders.

Using Full Edit Mode In Elements

Full Edit Mode
The full edit mode gives you everything you need to alter any of your images. You'll find 
that most of the tools and commands are found in the palettes. 

The palettes are used for managing your layers and applying effects to your images. By 
default the layers and effects palette are displayed automatically. If you wish you can also 
open more by choosing from the windows menu, which can be found at the top.

Another really cool feature for the palettes is they float, so you can have them where you 
like. Once you have brought your image up, you'll find below the main image window your 
images that you have opened.
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If you need to alter an image all you need to do is just click the thumbnail image.

Four great short tools and features

1 - At the top you'll see a quick undo and redo button. This is really cool as you don't need 
to keep going to the undo in the history palette.

2 - Any photos you have open are automatically stored in the bin at the bottom.

3 - Your tool box can be dragged and dropped anywhere on the screen.

4 - The buttons found at the top right give you the options of switching modes. Edit Create 
and Share.

Elements Tools
The more you practice with Photoshop Elements the more you will 
become familiar with many of the filter tools that are available to you 
and you will quickly figure out that you will want to apply different 
tools to different parts of your image.

An easy way to do this is to choose an area of your photograph that 
you wish to apply a filter to and "cut it" from the main photo then copy it into a new folder. 
Once you have done this step you can work on each part of the image independently from 
the others.

Finally, once you have finished adding your filters and effects to the parts you have cut 
away you can easily copy them back into the original image and relocate it to the proper 
position. It literally "snaps" into place when you line it up with where it needs to be.

I recommend playing with all the Photoshop Elements "Effects" tools to see what they can 
do with your image. It is also fun, when you have created some masterpieces, to try 
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changing them into black and white or keeping portions of your image as black and white 
while making others color. You should see a "painted effect" on the color portion.

Photoshop Elements Basics
Shown here is the Photoshop Elements toolbar, where all the basic tools reside. Hopefully 
this should be easily visible on the left of your main Photoshop window, but in case you're 
in any doubt a standard setup is shown here.

Below are the names of each tool, from top to bottom, with a short description. Some of the 
icons have more than one tool hidden away in them. This is shown by a small black triangle 
on the lower right of the icon. 

Here, I have grouped the names to show they share a button. To access the hidden tools, 
hold your mouse button down on the icon in your program toolbar until a secondary menu 
appears.

The Tools

 Move Tool - Much more than just move.

 Zoom Tool - Adjusts the current image magnification.

 Hand Tool - View different parts of your image without using the scroll bars.

 Eyedropper Tool - Places a colour from your image into the palette.

 Rectangular Marquee Tool - Makes a rectangular selection.

 Elliptical Marquee Tool - Makes an elliptical selection.

 Lasso Tool - Lets you draw on a selection shape.

 Magnetic Lasso Tool - Helps you draw a selection shape by helping trace certain parts  
of the image.

 Polygonal Lasso Tool - Lets you draw a selection shape line by line.

Copyright  David Peters • Master Photoshop Elements In Just 2 Hours – Guaranteed!

http://www.learnelementsnow.com/tutorials/index.htm#/a.php?a=mcknightmg


Page Page 1212 of   of  2929  

 Magic Wand Tool - Moves selections or images.

 Selection Brush Tool - Lets you draw a selection using brushes.

 Horizontal Type Tool - Inserts text horizontally.

 Vertical Type Tool - Inserts text vertically.

 Horizontal Type Mask Tool - Creates a mask from horizontal text.

 Vertical Type Mask Tool - Creates a mask from vertical text.

 Crop Tool - Removes the edges of an image.

 Cookie Cutter Tool - Cuts a custom shape out of the image.

 Red Eye Removal Tool - Removes red eye from photographs.

 Spot Healing Brush Tool - Helps repair damaged images.

 Healing Brush Tool - Helps repair larger areas of damage in images.

 Clone Stamp Tool - Duplicates parts of an image.

 Pattern Stamp Tool - Duplicates patterns or patterned images onto another image.

 Pencil Tool - Draws freehand like a pencil.

 Eraser Tool - Erases part of your image.

 Background Eraser Tool - Removes the background behind part of an image.

 Magic Eraser Tool - Erases all similar pixels in part of an image.

 Brush Tool - Draws with the selected brush shape.

 Impressionist Brush Tool - Changes parts of the image to look stylised.

 Color Replacement Tool - Replaces certain colors in parts of your image.

 Paint Bucket Tool - Fills an area with color.

 Gradient Tool - Fills an area with a blend between several colours.

 Rectangle Tool - Draws a rectangle of color.

 Rounded Rectangle Tool - Draws a rounded rectangle of color.

 Ellipse Tool - Draws an ellipse of color.

 Polygon Tool - Draws a polygon of color.

 Line Tool - Draws a line.
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 Custom Shape Tool - Draws a shape template of color.

 Shape Selection Tool - Allows the selection and movement of individual shapes.

 Blur Tool - Blurs parts of an image.

 Sharpen Tool - Sharpens part of an image.

 Smudge Tool - Smudges part of an image.

 Sponge Tool - Changes the vividness of part of an image.

 Dodge Tool - Lightens part of an image.

 Burn Tool - Darkens part of an image.

 Color Palette - Selects colors to use with other tools.

Histogram Palette In Adobe Photoshop 
Elements
The histogram in Elements works in the same way as it does in Photoshop, plus Elements 
histogram also gives you many options 
for viewing in tonal and colour 
information about your active image.

By default Elements histogram displays 
the tonal range of your entire image. But 
you also have the option of using the 
selection tools to select a portion of your 
active image, so this way you can see the 
histogram for that portion. 

The tonal range and colour values within 
Elements are really important to generate 
your great graphics which you are after, 
plus you can also see in the histogram palette your instant up to date information, you are 
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given the option to view to specific pixel or range using Elements histogram palette.

If you want to view this information on the range of values all you need to do is drag 
Elements histogram into Elements highlight range.

How the Histogram Works
The first you need to do is launch Editor, then click on the Window Menu and then click on 
Histogram. Next you need to click the Channel list arrow, you’ll then be given a list of 
different colour channels which you can view your histogram in.

RGB – This displays the tonal range for Red, Green and Blue.

RED, GREEN AND BLUE – This just displays the tonal range for Red, Green and Blue.

LUMINOSITY – This is for lightness

COLOURS – This just displays the tonal colour range.

Next you can click the source list arrow you can see underneath the Histogram. You then 
can select your image source. Which include the following. Entire Image, Selected Layer or 
Adjustment Layer.

If you wanted to refresh your image cache just click the Uncached Refresh button. You can 
also view information about your range values, all you need to do is drag the histogram into 
the highlight range.
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Colour Swatches Palette In Adobe 
Photoshop Elements 
Photoshop Elements like Photoshop has a colour swatches palette. Inside this colour palette 
you can choose any colour you like, also you have 
to option to store any new colour you might make. 
Lets say your doing a weekly newsletter and you 
want to save the colours you are working with, well 
all you have to do is save it in the colour swatches 
palette. 

It really doesn't matter what colour you need 
Elements has them all. Once your inside the colour 
swatches palette you are given several different 
options.

Default: This only displays the RGB and the pure colours.

Mac OS: This option lets you choose colours which are designed just for the MAC, plus 
you also have the options of adding hexadecimal values in.

Photo Filter Colours: This option will give you the warm colours

Web Hues: This option gives you the hues for the Web. This can be used on both systems 
Windows and Mac.

Web Safe Colours: Again this can be used on both systems, but it will only display 256 
colours.

Web Spectrum: This is used for the Web and can be used on both systems.

Windows: This will only display the colours which can be used on windows, plus you have 
the option of adding in hexadecimal values.

To get the most from your colours swatch palette you need to spend some time playing 
around with it, trust me its well worth doing.
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Master The Magic Wand Tool In Elements
Elements can do almost anything Photoshop CS3 can do, but Photoshop does give you and 
extra 10% more when it comes to those little 
gems for altering your photos. But, both bits of 
software come with the "Magic Wand Tool" or as 
one of my friends call it "Harry Potters Magic 
Wand Tool" don't ask me why because I have 
know idea.

Adjusting the contrast or colour balance of any of 
your photos or images can and is very easy, but if 
you only want to adjust the sky, lets say, brighten 
or darken it, or your landscape then this is when 
the "Magic Wand Tool" comes in. 

Basically the "Magic Wand Tool" selects pixels 
within a similar colour range, which enables you to apply a number of adjustments to one 
given area. 

How you use the Magic Wand Tool in Elements
First you start by opening your image up in full edit mode, next you need to select the 
Magic Wand Tool, you'll find this in your tools palette which is on the left handside of your 
screen, once this is open you need to then select the top bar and set your tolerance level to 
around 30. 

Next to tolerance box you'll see a tick box which say's "Contiguous" this must be ticked, so 
just put your mouse over the box and right click you mouse, you should now see the box 
ticked. The reason we are doing this is because we are telling the "Magic Wand Tool" to 
select the pixels of similar colour which are side by side, and not the colour which are 
outside the sky area.

Next you need to select an area of the sky or landscape from you image or photo, all you 
need to do here is just click it once, you will now see a running line which is dotted, this 
will now mark that selection. If you would like to select more of the sky just hold down the 
shift key and click the unselected areas.

Once you are happy with what you have selected you now need to open the Levels window 
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and select Enhance > Adjust Lighting > Levels, next just drag the slider bar to the right, 
you'll notice that you will add more atmosphere to your sky which as the dotted line around 
it, and nothing else in you photo or image has been touched.

Using Brushes In Elements

Using Brushes
Using brushes in Elements is very simple, but it's not easy when it comes to painting with 
your mouse with them. Okay let's go ahead and choose a brush. 

You'll see in your tool box on the right your brush tool and if you click on the little black 
arrow in the bottom corner a flyout box will appear, giving you four more options.

You'll also see in the top left hand corner your brush preview and if you click on that you'll 
get a selection of brushes to choose from. You'll see another little double arrow and if you 
click on that, you can change the way your brushes look…thumbnail, large thumbnail….etc.

Now if you click on the brush icon to the right you can access more additional settings for 
your brushes.

In here you'll see fade, hue jitter, scatter, spacing, hardness. You'll have to play around with 
these settings to find out what works best for you on your images or photos.
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You'll see in the image below the new flyout box appears after I clicked on the brush icon 
above it.

Four Great Tips to Think About When Using the Paint Brushes

1 - If you're painting on a photo, I would set your brush set to normal mode. You'll find it 
easy to paint the background.

2 - Using the impressionist brush will create a painted effect when you apply it to your 
image or photo. This is a really cool way of creating artistic affects.

3 - Colour replacement tool;- this for me has to be the best and most useful tool. If you set 
the mode to saturation and the foreground colour to black, you can selectively paint out the 
colour from the photo. If you need to switch colours, just switch the colour mode.

4 - If you need to blend, use the blending mode as this blends your brush strokes with the 
layer content.
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Using The Filter Gallery In Elements
Filters have now become one of the most used features in Elements; let's have a quick look 
at how to use them. Once you're in the filters section within Elements you'll notice that you 
are given a thumbnail of galleries of all 
the different effects. To view all these you 
need to select > Select Filter > Filter 
Gallery, or the other option you have is to 
select a creative filter from the filter menu 
to open the gallery, if you do it this way 
you'll see a preview of your image and a 
list of filters arranged in sets. 

Another great way to access your filters is 
via the Effects Palette which can be found 
in Elements 6, if you have Elements 5 
you'll have to find them this way, Artwork 
and Effects Palette.

Next you need to click on the arrow next 
to the name of a set to open it. So once 
you have clicked on that filter this then 
will be applied to your image. If you would like to select another filter just click on it in 
turn, as you will see your effects on your image will change and be replaced with the new 
one. 

Now if you would like to apply more than one filter you need to do the following, Select > 
New Effect Layer button, you'll find this at the bottom right, the great thing about this is you 
can add as many filters as you like, and another great thing within Elements when your 
adding new filters is you can stack them in any order you like, which will transform you 
image.

When you have selected most filters from the top right of your window you will notice a 
slider bar and menu for your controls, this will help you change the effect on your image. 
You will also notice that these are different for each filter; even some filters don't have any 
settings to alter. The best thing to when you are in the filters section is to experiment with 
your settings, you need to remember that there is no definitive rules here because each 
filters has it's own rules.

Once you are happy you just need to click the OK and apply a filter, if you're not happy just 

Copyright  David Peters • Master Photoshop Elements In Just 2 Hours – Guaranteed!

http://www.learnelementsnow.com/tutorials/index.htm#/a.php?a=mcknightmg


Page Page 2020 of   of  2929  

click cancel and return to the unaltered image. You need to remember that at full resolution 
you may not get the result you're looking for; this will happen a lot with high res images. If 
you zoom out so your image fits your screen it will sometimes hide the detail from your 
image because of the filter, so make sure you zoom in to 100% so it shows you your full 
effect of your filter on your image.

Resizing Your Images In Elements
Most people need to resize there images and it always causes a lot of confusion so I'm going 
to try and make it a bit more simpler for you. Ok lets start right at the beginning, digital 
photos are made up of pixels which are the 
picture elements. Your camera will determine 
how many there are in your photo.

If you resize one of you images all you are 
doing is specifying a new print size which the 
pixel are spread over, you must remember your 
not changing the number of pixels in your 
image. That's the easy bit out of the way, and 
now this is the bit most people get confused 
about. If you resample an image in Elements 
you're adding or removing pixels.

Elements gives you both of these options and they can be found Image > Resize > Image 
Resize Dialog. If you do this and all you want to do is resize the image just leave the 
Resample Image option disabled, like I said before all you are doing here is spreading you 
pixels over a greater or smaller area.

Some quick notes you should know in the Image Size dialog box. If you enable the resize 
image option in the Image Size dialog you can just alter the dimensions by the pixel count 
instead of the size. If your resample image is enabled you'll be presented with a list of 
resampling methods. I have found that Bicubic does give you the best results, but if your 
enlarging images make sure you use Bicubic Smoother.
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Retouching And Correcting Images
As all digital photographers know digital 
cameras can take some amazing photos, but 
sometimes your photos just fall short of being 
perfect. Elements has all the tools necessary 
to make your photo perfect. Okay, let's get 
started and let's get to grips with most of the 
everyday tools you’ll be using. 

Levelling Your Image By 
Cropping
Even professional photographers don’t get all their photos correct the first time. In fact I 
would say that over 95% of the use of Photoshop or Elements is to correct their images, so 
you’re not alone with this. Once you have your photos in a folder you’ll notice that some of 
your photos might have looked better if you’d have shot it differently. Either it might have 
been better zooming in more, or you need to crop your photo, or even rotating your photo.
What you’ll also find is that most digital cameras have a ratio of 4:3 which means; (4 units 
wide by 3 units high) the standard print size is 6×4, which is a ratio of 3:2 (3 units wide by 2 
units high). You can alter your image or photo in the aspect ratio dialogue.

If you need to crop your image or photo to a specific size you can. Just open up the aspect 
ratio dialogue and to do this you need to click on image > crop. If you look at the top you‘ll 
see a width and a height box and you can work these in inches or centimetres. For inches 
just type in "in" and for centimetres just type in "cm". 

Personally I never enter anything in the resolution box, the reason being Elements 
automatically re-samples your image or photo. As you can see in the image above I have 
cropped and sized my image to fit aspect ratio of 2.5 x 2 in.
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Understanding Grayscale In Elements
As you know you can turn your images or photos into grayscale via Elements. The 
grayscale colour mode uses an 8 bit pixel which is 
made up of the following (8 on/off light switches) to 
generate 1 black and 1 white and 254 shades of gray. 
One of the ways to use grayscale images or photos is 
via scanning, the reason being it's easier to scan in 
black and white. 

You find now a days mainly because of the speed and 
the power of Photoshop Elements most photo restorers 
are switching to RGB colour space, and the main 
reason being because of it's versatility, because it can 
generate millions of colours, or in this case millions of 
shades of gray.
 
Despite the very big move to RGB the grayscale 
colour mode is still used extensively on nearly all 
black and white photos or images, this is because of the files size. Grayscale images are 
2/3rds smaller than RGB, so this is a great help to all the newspaper and magazines because 
they lack the ability to produce the detailed images or photos.

Using Grayscale In Elements
1 - Open you editor and then open you image.

2 - Next you need to click on the image menu, and then select point mode, and then click on 
Grayscale. You'll now see that you image has been converted into Grayscale.

3 - You might be prompted, if so click Flatten or Merge, to merge multiple layers into one.

4 - Next click OK to discard colour information.

Also you can colour a grayscale image. To do this you need to be in Editor, next convert 
your image into the RGB mode, next you need to create a new layer, this needs to be above 
your image layer. Next you then need to select your brush size, this can be found in the 
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Options Bar at the top. You need to change the blending mode of the brush for this to work.

Next just colour your image and the new colour you have selected will replace the gray.

Adjusting Levels in Your Photos or Images
Before you begin editing it's always a good idea to check a photo's 
levels.  When photos are  backlit,  lit  poorly,  or  overexposed,  the 
colors  tend  to  not  look  quite  right.  At  times  this  is  obvious, 
however at  other  times it's  hard to  tell,  so  you always want to 
check your photo's levels. Doing this first will help you make the 
colors in your photos look their best.

To change the levels in your picture click on Edit in the menu bar. Move your mouse to 
Adjustments > in the drop-down menu and leave the cursor there for a second. In the sub-
menu that pops up, choose on Auto Levels. 

After adjusting the levels you should see a change in the appearance of your photo. It’s okay 
if you don't see a noticeable difference. If there is no change it simply means that your 
photo looked good right from the start. After you have adjusted the levels save your work by 
hitting Apple + S in Mac OS X or CTRL + S in Windows.

As you work with Photoshop you will find there are keyboard shortcuts that you can use for 
speed up your work; the keyboard shortcut for Auto Levels is Shift + Apple + L on a Mac or 
CTRL + L on a PC.
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Elements Brightness And Contrast 
Adjustment
When you’re using Elements you’ll have the chance to change the brightness and contrast 
within your image. The brightness and contrast adjustment changes your image by the 
overall darkness and lightness of your image 
pixels. It’s a great way for special effects. 

If you just need a quick adjustment to your 
image this is the best way. Curves and 
Levels are a much better way of adjusting 
your image.

In elements, the brightness and contrast 
adjustments performs a linear adjustment for 
your new image. When you open the 
brightness and contrast adjustment you’ll see a slider bar, if you want to increase the 
brightness just move it to the right, this will increase the pixels within your image. This 
works for both brightness and contrast.

You might not know this but photographs are not linear in nature, so it’s best to use Curves 
and Levels (non linear). So if you are going to use brightness and contrast I would 
recommend using this on clipart text and clipart images, or just non photographic images or 
photos.

So to use brightness and contrast you need to open up Elements and then select your image. 
Your next step is to click Enhance menu, you’ll then have a drop down, you then need to 
select Adjust Lighting and the select Brightness/Contrast. Now make sure you have the 
Preview checked, this allows you to view your changes on your active image. To alter the 
Brightness just slide it to the right to increase the Brightness values, or just slide it to the left 
to decrease the Brightness values.

To alter the Contrast you need to slide the slider bar in the way. To the right increases the 
Contrast, to the left increases the Contrast. Once you are done just click OK.
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Replace Colour Adjustment In Elements
Another very impressive tool within Elements is the “Replace Colour Adjustment”, 
basically this lets you create a selection 
which is based on image colour and 
replaces that colour selection with any 
other colour. 

The way this works is very simple but 
it’s very affective, the “Replacement 
Colour Adjustment” accomplishes this 
by giving you access to the three main 
items which control the colour within 
Elements. They are Hue, Saturation and 
Lightness.

So what does each of these do? 

Hue allows you and gives you the ability to change the images physical colour. Saturation, 
will this allows you and gives you access to control the amount of colour. Lightness, well 
this speaks for it’s self, it allows you to determine the brightness of the colour, but this is 
based on Hue and Saturation.

How Do You Use the Replace Colour Adjustment?
The first thing you need to do is open Elements, then open you colour image. Next you need 
to click on Enhance Menu, the click on Adjust Colour and then click on Replace Colour.

Next you’ll see a Preview box you need to make sure this is ticked. Then you need to click 
on your active image with your selection eyedroppers to select, add or subtract colours.

Once you have done that, you then need to click on the Colour Box to select the colour 
which you’re after. Then drag the fuzziness slider which you’ll also see, you can drag this 
from right to left, this will increase or decrease the sensitivity of the eyedropper tool.

Now you need to click on your Selection or Photo/Image option to toggle between a view of 
the selection mask and the active image, you’ll notice that the white areas are the active 
ones. Then you just need to drag the Hue, Saturation and Lightness sliders to give you the 
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right colour.

How To Use Automatic Lighting And Colour 
Commands In Elements
Automatic lighting and colour commands make is really easy to alter any problems you 
might have with your lighting or colours in your images or photos. The auto commands 
receive information from their adjustment queues which is in the active image or photo.

Here's a quick example if you have an image with a big white border Adobe Elements auto 
command will factor that information into the correct image or photo. If you are applying 
this command then it would be best if you corrected any dust or scratch problems before 
you crop out any borders.

To use automatic lighting and colour command you firstly need to open up your image in 
Editor, then click on the Enhance Menu. You'll then be given a drop down menu with a full 
list of commands you can use.

Auto Smart Filter: This will correct the overall colour balance of your photo or image. The 
shortcutfor this is (Alt + Ctrl + M).

Auto Levels: This will adjust the overall contrasts of your image or photo, it will affects 
your colours. This also maps your colours from the darkest to the lightest. The shortcut 
command is (Shift + Ctrl + L).

Auto Contrasts: This basically adjusts the overall contrasts of your image or photo and it 
doesn't affect the colour in your image or photo. The shortcut for this is (Alt + Shift + Ctrl + 
L).

Auto Colour Correction: This will adjust your contrast and your colour of your image or 
photo. This neutralizers the midtones and sets the white and black points. The shortcut for 
this is (Shift + Ctrl + B).

Auto Sharpen: This just sharpens your image or photo. 

Auto Red Eye: This command will detect any red eye and it will remove it for you. The 
shortcut for this is (Ctrl + R)
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Photoshop Elements - File Formats
In Elements you have the option of saving your images in any one of 15 types of file 
formats, giving you the possibility of creating images for a variety 
of different projects. This includes images for the web, for 
slideshows, and for many different forms of printing.

Elements can also create images specifically for the web. 
Preparing your images for your website is simple and easy with 
Photoshop Elements. It also helps you to resize and compress 
images that are being attached to an e-mail.

Using HTML creating a web gallery can be a lot of work but with 
Photoshop Elements you can open a group of images, resize them, create a thumbnail 
gallery and create all the navigation HTML buttons for your site. It also creates a folder for 
your web files and saves it on your computer.

Sending Photo Mail In Adobe Elements
Elements just has about every new gizmo going, and one of the new and cool features is 
Photo Mail. Just think about how easy it will be to send one of you awesome new photos 
you've just altered with just a few clicks of your mouse.

It's really very simple to do, your first steps are the same as you would if you was to send an 
Photo Attachment. This time you need to click on the Photo Mail button instead, you'll find 
this under the Share Tab. 
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Once you've clicked on that you'll then be given a selection of photos where you can either 
select or de-select, then it's just a case of adding your recipients mail address.

In Elements, you are given an option to add a stationery template if you like, Elements also 
gives you the option of choosing the design theme you want to use. Once you have chosen 
your design theme you are then allowed to configure the layout options. You'll find these 
options in the control panel which are on the left. Your options are; Choose the photo size, 
layout of the photos, and your different font and text. You are also given an option which 
you can add a caption if you like.

With Photo Mail you are given two options for sending mail, plain text or HTML format 
which most people use these days. With the HTML email you can get a more attractive 
layout skin to your gallery of photos, plus another great benefit is your recipients can view 
your photos without having to double-click your attachment icons to open them.
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Master Adobe Elements In Just 2 Hours 
With Breakthrough, Online Video Tutorials 

- Guaranteed (Even If You're A Total 
Newbie)!

This brand new step-by-step video training system shows anyone how to go from 
complete newbie to confident Photoshop Elements user in just 2 hours...

Click Here to receive a FREE SAMPLE ADOBE 
ELEMENTS VIDEO TUTORIAL Compliments of: 

www.LearnElementsNow.com
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